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Preface

This VBPresenter User Guide is written for anyone who will be using or evaluating 
VBPresenter. VBPresenter is an add-in for Microsoft PowerPoint that lets you create and 
record live multimedia presentations using the standard Microsoft PowerPoint application 
that is included with the current versions (at this writing) of Microsoft Office. VBPresenter is 
created and supported by VBrick. If you have VBrick WM (Windows Media) on your 
network, VBPresenter can add streaming video to your multimedia PowerPoint presentations 
in a matter of minutes.

VBPresenter v2.x works with VBrick's WM or MPEG-4 appliances and uses the Windows 
Media Player interface. VBPresenter v3.0 supports VBrick WM video only. It delivers an 
advanced interactive viewer interface using Microsoft's Silverlight technology.

Organization

Getting Help
If you need help, or more information about any topic, use the online help system. The 
online help is cross-referenced and searchable and can usually find the information you need 
in a few seconds. Use the tree controls in the left pane to open documents and the up and 
down arrows in the right pane to page through them. Use the Search box to find specific 
information. Simply enter one or more words in the box and press Enter. The search results 
will return pages that have all of the words you entered highlighted in yellow (Internet 
Explorer only). The Search box is not case-sensitive and does not recognize articles (a, an, or 
the), operators (+ and – ), or quotation marks. You can narrow the search by adding words. If 
you can't find the information you need from the online help, or from your certified VBrick 
reseller, you can contact VBrick Support Services on the web. Support Services will make 

Note VBPresenter v3.0 requires VBDNA v4.2 or above for direct streaming from a WM 
appliance to viewers. Earlier versions of firmware are acceptable when streaming 
via a service or from a Windows Media Server.

Getting Started Explains how to install and configure the add-in. It also describes 
how to choose a web server and how to configure the add-in with 
an external configuration file.

Using VBPresenter Explains how to use VBPresenter functionality to provide live 
streaming video with your PowerPoint presentations.

Best Practices Explains some of the techniques you can use to create effective 
presentations including managing bandwidth and guidelines for 
your PowerPoint presentations.

VBPresenter with M
CS

Explains how to use VBPresenter with VBrick's MCS Portal Server.

Troubleshooting Provides answers to common problems and frequently asked 
questions about VBPresenter configuration and usage.

http://www.vbrick.com/support
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every effort to answer your technical questions in 24 business hours or less. Note that all 
VBrick product documentation is posted on the web at www.vbrick.com/documentation

Font Conventions
Arial bold is used to describe dialog boxes and menu choices, for example: Start > All 
Programs > VBrick
Green Courier fixed-width font is used for code elements (C++, HTML) as well as 
filenames, directories, etc.

Black Courier fixed-width font is used to indicate user input in keyboard commands, 
scripts, etc.

Folder names and user examples are displayed in this sans serif font.

Folder names and user input are displayed in this bold sans serif font.

Italics are used to emphasize specific words or phrases.

Printer-Friendly
Click on the link below to print a hard copy of this document in printer-friendly format. For best 
viewing, open and resize the document using the magnification box at the bottom of the 
Acrobat Reader window.

VBPresenter User Guide

VBPresenter Release Notes

VBPresenterUserGuide.pdf
http://www.adobe.com/products/acrobat/readstep.html
http://www.vbrick.com/documentation
VBPresenterReleaseNotes.pdf
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Chapter 1

Getting Started
Topics in this chapter

Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1
Software Installation  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3
VBPresenter Configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5
Configuring a Web Server  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12

Overview
The VBPresenter PowerPoint Add-In is used to give and record live multimedia 
presentations using conventional Microsoft PowerPoint. It operates in both PowerPoint 
Normal view and Slide Show view. The add-in converts your current PowerPoint 
presentation, uploads it and specially formatted viewing pages to your web server, and 
communicates with a target VBrick Windows Media appliance. This means viewers can see 
your live video, hear your live audio, and watch your live fully synchronized PowerPoint slides 
and web pages. During a live presentation, your audience may ask you questions via the 
Asking Questions feature.

Figure 1.  VBPresenter Recorded Presentation

The add-in generates two viewing pages, one for conventional Internet viewing (unicast) and 
one for local viewing in an enterprise network (multicast). The system allows a presenter to 
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reach thousands of local viewers without excessive wide area network bandwidth usage, and 
also reach a world-wide Internet audience. You can use a VBrick Reflector, a Windows Media 
server or a hosting service to replicate the VBPresenter video feed for remote viewers. 
Hosting services are available from VBrick partner PowerStream and other vendors.

An important innovation with this add-in tool is that PowerPoint operates normally while it 
communicates with your VBrick and manages the online presentation process. Presenters 
who are already familiar with PowerPoint need not change their normal behavior. In 
PowerPoint Normal view, the add-in keeps perfect synchronization with your VBrick audio/
video, but also allows you to receive live questions from your audience via built-in "instant 
messages." In a presentation venue, you can connect a projector to your computer to show 
your PowerPoint material to your audience normally. The add-in tool bar is not visible during 
PowerPoint Slide Show mode, but it silently controls your live presentation online. The add-
in software will record your live VBrick WM presentation and publish it on your web server 
for instant on-demand viewing.

Viewing Pages

The viewing page for live presentations displays the Ask Question dialog, while the same 
page for viewing stored presentations displays a Navigate button that enables thumbnail 
image viewing and selection. The viewing page also provides an option for viewing closed 
captions (if they are available). Clicking on the slide image or the video smoothly swaps and 
expands one or the other. Mousing over the slide or the video will display (or hide) the 
control buttons. When the video is expanded, the buttons may be hidden: click on the slide to 
reduce the video and expose the buttons.

Stop and Play are always available; Pause is only functional for stored video. The Reference 
button displays any uploaded reference material via a popup window. The Full Screen button 
opens the video/slide in full screen mode. Clicking on the screen will swap which one is full 
screen and which one is shown as an insert in the upper-left corner of the viewer's screen. 
The Ext Video button launches a popup resizable video viewer using Windows Media Player 
(Windows PCs only). The external player has a slide bar for granular navigation of stored 
presentations.

The Ext Slides button launches a popup resizable slide viewer. Both the Ext Video and Ext 
Slide viewers maintain synchronization with the viewing page and with each other. The 
external viewers are particularly useful for dual-screen monitor setups because you can drag 
the video to one screen and the slides to another. The Navigate button displays the slides 
used in the presentation. Clicking on any slide will cause the video to play at the position 
where the presenter showed it.

Viewing Page Addresses

The home page for presentations is http://yourServer/yourAccount/index.asp. This page 
displays Click To View Live Presentation - [PowerPoint Name] whenever you are online. 
This link is not shown when you are offline. You can also navigate to your viewing page using 
http://yourServer/yourAccount/PowerPoint Name or by using the link shown in 
VBPresenter after uploading your live or stored presentation. When you publish a recorded 
presentation, it will be listed on the primary viewing page with an image of your first slide, 
the title, and the upload date. You can sort the list by clicking on the column heading.
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About Logins and Passwords

Viewers of live presentations are asked to login. This establishes their identity so that the 
presenter knows who is viewing and who is asking questions. Viewers of recorded 
presentations are not asked to login. When uploading a new presentation, the presenter may 
assign a password. This password must be entered correctly by anyone wishing to view the 
presentation.

When uploading (that is "publishing") a recorded presentation, the presenter may assign a 
password. This password may be different from the one used for a live presentation. This 
password must be entered correctly by potential viewers. Thus you have a reasonable 
assurance that if you publish recorded presentations, they cannot be viewed by unauthorized 
viewers even though they are listed on the home page.

Managing Presentations

You can manage presentations by navigating to the VBPresenter Setup window and selecting 
Manage on your web server. Simply delete any folder you no longer wish to retain (the folder 
name is always the name of the original PowerPoint file). Note that within each folder, there 
may be the following files:

• Live.txt – tells the home page that this is the current live presentation. If you fail to select 
Offline, this file will remain on the server and you can manually delete it (or simply open 
that presentation again and select Offline).

• Recorded.txt – tells the home page to list this presentation. If you wish to retain a 
recorded presentation but not list it on the home page, simply delete this file.

Software Installation
It only takes a few minutes to install VBPresenter. Before installing VBPresenter, close 
PowerPoint and remove any previous instances of VBPresenter using Add or Remove 
Programs on the Control Panel. Note that if you have previously defined configuration files 
created with the VBPresenter Admin tool, they are automatically saved when you upgrade.

To install VBPresenter:

1. Insert the VBPresenter Product CD in your computer.
2. Navigate to the "VBPresenter Software" page, double-click on the setup program, and 

follow the online instructions. Click Finish when done.
3. After running the setup program, open PowerPoint and verify that the VBPresenter 

toolbar (see below) is present. If not, go to View > Toolbars and select VBrick 
VBPresenter.

4. If prompted by PowerPoint, select Enable Macros and Initialize ActiveX controls.

Note When using VBPresenter with the MCS Portal Server, passwords are not used for 
presentations. Instead the Portal Server access control system is used to prevent 
unauthorized access.

Note Macintosh viewers must install Windows Media Player in order to view WM 
presentations in Safari or Firefox.
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VBPresenter Toolbar

When the add-in is installed, it will show up as a new PowerPoint toolbar. By default, the 
VBrick VBPresenter toolbar will be loaded automatically each time you open PowerPoint. 
You can dock or undock the toolbar by simply dragging it to the desired location. Mouse over 
any tool to see the tool tip text. VBPresenter functionality is explained in more detail in 
Using VBPresenter Tools on page 23.

Table 1.  VBPresenter Tools

Icon Description

Launches VBPresenter Setup window.

Uploads the current PowerPoint presentation to the specified web 
server

Sends a pre-formatted email message that you can use to launch a 
presentation. It includes a unicast URL and a multicast URL.

Use to monitor the video being viewed or recorded, or to open 
the current presentation. When you monitor the video being 
recorded, it is low delay without audio.

Set the VBPresenter to LIVE ONLINE or OFFLINE.

This icon is displayed only when VBPresenter is LIVE ONLINE.

Set recording to START or STOP.

This icon is displayed only when a recording is in progress.

Show web page and conduct guided web browsing.

Conduct audience polling. 
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VBPresenter Configuration

Hardware Configuration

A typical VBPresenter setup is illustrated below in Figure 3. There is a person using 
PowerPoint to give a presentation. A camera and microphone is connected to a VBrick and 
the camera and microphone is aimed at the person giving the presentation. Because 
everything is connected to the network, physical proximity is not important. The video 
source and the presenter can be virtually anywhere. Also, note that the video source may be a 
VCR or camcorder, allowing you to add multimedia to a previously recorded video. Of 
course, your video source may be a pre-existing room "A/V System." A significant advantage 
over other systems is that everything happens over the IP network, whether it is wired or 
wireless. There is no tether to legacy analog VGA cables. This means that you can use your 
laptop with wireless connectivity to your network. See Typical Configurations on page 37 for 
other possibilities.

Figure 2.  Typical VBPresenter Hardware Setup

Show VBPresenter login status and audience questions by 
opening a browser. The presenter can view audience questions in 
real time.

Send text messages to viewers. Useful for start-up banners (for 
example "The next presentation will begin at 2:00 P.M.")

Publish your recorded presentation to web server.

Add References. Make PDFs, Word documents, PowerPoint 
presentations, etc. available to your viewers.

Manage Presentations. This allows you to select and launch 
presentations or delete presentations.

Video 1 or Video 2. Switch between dual video inputs. These 
inputs can have user-friendly names configured on setup page.

Online help (this user guide in online HTML format).

Icon Description
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Software Configuration

In order to create a presentation with VBPresenter, you must configure a web server that will 
host your PowerPoint slides and a video source from which your audience will view the video. 
The possible options are shown in Table 2 below.

Table 2.  Web Server and Video Viewing Options

† See VBPresenter with MCS on page 39 for more about Portal Server configuration.

VBPresenter Setup Window

Click on the setup icon to launch the setup window shown below. Use this window to enter 
the details about your web server and your VBrick appliance. Mouseover any field to see a 
helpful tooltip for that item. The requirements for each entry are explained in the table 
below; see Configuring a Web Server on page 12 for more information about configuring 
your specific web server. When you open the VBPresenter Setup Window, the configuration 
file config.vb1 is opened by default. Use the Load button to select a different configuration 
file.

Web Server • Windows web server, e.g. Internet Information Services (IIS).
• VBrick (MCS) Portal Server †

Video Viewing Live • View video from a VBrick using internal multicast.
• View video from a reflector using external unicast.
• View video from a VBrick or a reflector via MCS.

Stored • View video from a streaming server.
• View video via progressive download from a Windows web 

server.
• View video from MCS using the Portal Server as a 

progressive download web server.

Note The VBPresenter setup window is sticky. This means your entries are preserved when 
you close the setup window as long as you don't exit PowerPoint.
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Figure 3.  VBPresenter Setup Window

Automatic Configuration Address

Automatic 
Configuration Address

Use as directed by VBrick Support Services only. Enter the fully-
qualified URL to a configuration file (supplied by VBrick Support 
Services) and click Load. This will enter all needed settings for 
conducting a webcast via the public Internet, except for your local 
VBrick IP address. Enter your local VBrick IP address, username, 
and password then click Set Publishing Point.

Serial Number Enter the provided VBrick serial number and click Set. 
VBPresenter installations without a serial number are not eligible 
for support from VBrick. Once set, this entry cannot be changed.

VBrick Appliance

VBrick IP Enter the VBrick host name or IP address. This is the VBrick 
Windows Media appliance (Slot 1 only). Use the Manage button 
to modify appliance settings. If VBPresenter is LIVE ONLINE, be 
sure to go OFFLINE before editing the appliance settings in IWS.

Username Enter the username of the VBrick (default is operator).

Password Enter the password of the VBrick (default is operator).

Mgmt Port Enter the http management port of the VBrick. (The default is 80 
but this is often changed to 8080 to allow the VBrick to stream 
video on port 80.)
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Composite/S-Video Sets the video input on the VBrick to Video1 (Composite) or 
Video2 (S-Video). This lets you switch back and forth between 
two cameras or other video sources. You can enter a value in each 
field, e.g. Camera and Document, to help you remember which is 
which.

Push Host or IP DNS server name or IP address of push destination. Include the 
port number if the number is not port 80, for example: ip:port If 
entering HTTP Push information, press Set Publishing Point 
when done. This populates the Encoder > Push page on the WM 
appliance with these values.

Publishing Point Sets the name of the publishing point on the WM appliance to 
accept the push.

Push Username Local user name or domain/active directory user name

Push Password Password associated with the Username

Start/Stop Push with 
Online/Offline

Enables a push on the encoder when going on or offline in 
VBPresenter. When pushed will write content in the Push Host or 
IP, Publishing Point, Push Username, Push Password to the WM 
VBrick.

Archive Publishing

Progressive Download A standard web server to deliver the WM video stream via 
progressive download.

Use Streaming Server Use the streaming media server defined below to deliver the 
video. The video is uploaded to this FTP account. When you 
publish a recorded presentation to a streaming server, the video 
file is uploaded to the server via FTP. 

Streaming Server

Streaming Server Displayed when you select Use Streaming Server above.

IP or Host This is the IP address or host name of the streaming server to 
which you will upload your presentation. Enter the IP address or 
Host Name of the server. Do not enter "HTTP://" and do not 
enter subdirectory. The FTP account should place you into the 
target directory when you log in.

Username Enter an account username on the streaming server.

Password Enter an account password on the streaming server.

Rmt Dir Enter the remote directory for your video. Typically this is the 
same as your username but you may have a special folder assigned 
for your presentations.

URL The URL is the base fully-qualified URL for viewing a .wmv 
video. For example, if you upload myvideo.wmv to foo/myvideo, 
then enter http://foo/myfoo, VBPresenter will append 
myvideo.wmv to this URL.

FTP/Web Server
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IP or Host This is the FTP/web server to which you will upload your 
presentation. Enter the IP address or host name of the server. Do 
not enter "FTP://" and do not enter a subdirectory. The FTP 
account should place you into the target directory when you log 
in. Use the Manage button to open an FTP window (via Internet 
Explorer) to the server. For MCS, enter the IP address or host 
name of the Portal Server. See Configuring a Web Server on 
page 12 for more about configuring a web server.

Username Enter the FTP account username.

Password Enter the FTP account password.

Rmt Dir Enter the remote FTP directory. Typically this is the same as your 
username but if you are using your corporate web server, you may 
have a special folder assigned for your presentations.

Web URL Enter the URL for viewing content via HTTP from your server. 
This is normally the same as the IP address or host name plus "/" 
plus your Remote Directory, but may be a WWW address. Some 
server accounts (e.g. PowerStream) use a different server for 
upload than for publishing. See Troubleshooting on page 47 if 
you need help. If web server is a VBrick MCS, set the URL to 
http://MCSIPAddress/Presentations/server

Right: http://servername/username

Wrong: http://servername/username/

MCS Check this box if your images will be uploaded to a VBrick Media 
Control Server (i.e. the MCS Portal Server). This displays the 
MCS Program Name field. The program name is the actual text 
that will be displayed on the Live Broadcasts page when you 
access this stream from MCS. See "Global Settings" in the Portal 
Server Admin Guide for more about program names.

MCS Program Name This is the title that will be displayed on the Live Broadcasts 
page during a live Portal Server presentation. See "Global 
Settings" in the Portal Server Admin Guide for more about 
program names.

Video URLs

Video Viewing Enter the video URL for viewing live video. This is typically the 
URL from a WM reflector or service. This can also be the http 
address of the WM appliance video stream (e.g. http://

vbrickip:port/streamname). See Selecting a Video Viewing URL 
below for more information.
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Selecting a Video Viewing URL

The video URL is the URL where your audience will view your live video, or the URL used to 
record your presentation. There are several possible choices, depending on your 

Video Recording Enter the video URL for recording. This is typically the VBrick 
appliance streaming server. Press Record from VBrick to enter 
this URL automatically (this populates the field with the HTTP 
URL of VBrick Slot1). This is commonly the same as the above 
Video Viewing URL. However, if you are using a reflector server 
or using multicast, you may have a better recording result by 
recording directly from the VBrick rather than the URL used by 
your viewers. To record directly from your VBrick, enter: 
http://VBrickIpAddress:port/streamname, 
(for example http://192.168.1.10:8080/vbrickvideo1). For 
multicast, enter http://VBrickIpAddress/vbs1multi.nsc

Thumbnail Offset (sec) Recorded presentations only. Sets the number of seconds that the 
video should start early when a viewer selects a navigation 
thumbnail slide. This is useful for improving the viewer 
experience depending on the style of the presenter.

Video List Title VBPresenter automatically creates a master viewing page for your 
live and stored video. This web page is uploaded to your server 
and is named /index.asp. Enter the title you wish to use for this 
page and click Show List to launch the page. You can copy the 
URL from your browser address bar for future reference.

Other

Image Size Adjusts the size (Small, Medium, or Large) of the PowerPoint 
slides shown in the VBPresenter window. Normally, you use 
Medium. In general, larger images take more space but provide 
better image quality. However they can be slower to load if you 
have too many live viewers.

Refresh If a viewer is joining a live presentation, the first slide may not be 
displayed until the presenter actually clicks on a new slide. Use 
this feature to refresh the window and display a slide for new 
users. Default = Slow. Set to Slow, Medium, Fast, or None which 
will refresh the slides every 120, 60, or 30 seconds, or never.

Max Viewers Sets the maximum number of live viewers allowed to login to your 
presentation. Default = 1000. You may want to adjust this value if 
you have limited bandwidth.

Viewer Timeout (sec) This sets the maximum number of minutes during which a viewer 
may ask questions. It also operates as a mechanism to remove 
viewers from the list if they do not logout normally (for example 
during a power loss). A live presentation session will automatically 
timeout when it exceeds this value. Default = 7200 sec (120 min).

Upload Presentation Uploads your PowerPoint slides to the web server specified 
above.

Close Closes the VBPresenter Setup window and saves your changes.
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configuration. When in doubt, open Windows Media Player and type in the proposed URL to 
be sure you can view the video.

VBrick Appliance Configuration

Set up your VBrick WM appliance normally and make sure you have Meta Data enabled (in 
IWS, go to Configuration: > Encoder > Video). The Meta Data option must always be 
enabled when using VBPresenter and a WM appliance. You may also need to enable Closed 
Caption and Metadata in three places: on the Configuration: Encoder > Multicast, Server, 
and Push pages. The three Closed Caption and Metadata options may be important 
depending on how the VBPresenter viewers are receiving the stream. If they are watching via 
multicast, then the metadata enable on the Multicast page is important. If they are watching 
via RTSP and/or HTTP directly from the VBrick, the metadata enable on the Server page is 
important. If they are viewing the presentation from a server reflecting a push from the 
VBrick (for example with PowerStream), the metadata enable on the Push page is important. 
You may want to enable all of these options just in case.

If you are sending to a public Internet audience, you will want to keep your streaming 
bandwidth within reach of your intended audience. In most cases, this is in the 100–500 Kbps 
range. If you are using multicast, you might wish to disable the Announce SAP feature so 
that viewing occurs only via your presentation viewing page. Generally, once your VBrick is 
set up such that your intended viewers can see your video on their computer via a player (for 
example VBrick StreamPlayer or Windows Media Player ), you have done what is needed to 
give your presentation.

VBrick Reflector Configuration

VBrick has partnering agreements in place with web hosting service providers for prepaid 
web hosting for a limited, trial period. If you are using such a service provider for your video, 
they will provide the values to use when configuring the VBrick appliance. These values are 
generally case-sensitive and must be entered carefully. If you are using a reflector (e.g. 
PowerStream, your own WM server, a VBrick Reflector), you must set up HTTP push on 
your VBrick appliance. After logging in to your appliance, go to Configuration: Encoder > 
Push. Then enter the server IP address or hostname, the publishing point, username and 
password. In this configuration, the VBrick will send your video to the reflector server.

The Video Viewing URL in the VBPresenter setup window is used to view the live video. This 
viewing URL is the URL of the reflector—not the URL of the VBrick appliance. If you are 
viewing from a reflector, the URL is provided by your service provider or is the address of 
your reflector, for example http://serverIp:port/streamname. See Using a Reflector Server on 
page 38 for more about reflecting.

Appliance Type Viewing URL

Windows Media • http://vbrickIpAddress:8080/streamname – direct viewing 
from the VBrick appliance.

• rtsp:// or http://reflectorIpAddress/publishingpoint – used 
when the VBrick is pushing video to a reflector server and 
viewers view the video from the reflector server 

Note If you purchased the VBrick webcasting kit, a camera with a microphone was 
included. To use a different audio source, you may need a microphone pre-amplifier, 
a wireless microphone with live level audio out, or a room audio system.
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Configuring a Web Server
This section explains how to configure an FTP/Web Server for VBPresenter. When using 
this section, you may wish to refer to the VBPresenter Setup Window on page 6 for more 
about specific parameters. You need a web server to host your PowerPoint slides and web pages. The 
VBPresenter PowerPoint add-in works with Microsoft IIS and VBrick MCS. The Audience 
Poll feature uses ASP technology and works only with IIS. (Your IIS web server account 
must allow read/write for Internet users. If you do not set permissions properly, or if you do 
not host on a server that supports ASP, audience questions and login status reporting will not 
work and your viewers will receive a "page not found" 404-type error when they submit a 
question.) As shown in Table 3 and explained in more detail on the following pages, you can 
use any of the following as a web server for VBPresenter.

Table 3.  Supported Web Server

Server Type Description Supported Appliances

IIS Use Internet Information Services (available in all 
versions of Windows Server 2003) as a web server.

WM

MCS See VBPresenter with MCS on page 39. WM
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Using IIS as a Web Server

In a typical VBPresenter scenario, a user site may have a Windows Media Server (as a 
reflector), a WM VBrick encoder appliance, and VBPresenter to give rich media 
presentations. For an existing web server, you simply need a FTP account such that when you 
log in and upload files, those files can be accessed via http. This is the most common 
configuration, and your FTP login should put you in the desired directory. For example, your 
web server might have a directory called "mydir". You might login to your server via FTP 
with username "mydir" and password "mypassword" which will automatically place you in the 
"mydir" directory. In this case, you will enter "mydir" as your username, "mypassword" as 
your password, and "mydir" as your remote dir in the VBPresenter setup. When you upload 
presentations, a new folder with the PowerPoint name will be created on your server. You can 
easily use your "personal home page" that is provided to most ISP subscribers. For any 
Microsoft web server you will need to set up a FTP account, username and password via 
Microsoft IIS.

Configuring IIS for VBPresenter
Here is an example of how to configure IIS Version 6.0 (Windows Server 2003 Web Edition) 
as a web server for VBPresenter. You must create a user, a folder, and virtual directories as 
explained below. The user, folder, and virtual directories must all have the same name. Use 
any name you wish but they must be identical. This example uses Presentations for the user, 
folder, and virtual directory names.

To configure IIS as a web server for VBPresenter on Windows Server 2003:

1. Create a Windows folder where your presentations will be saved, typically C:\Program 

Files\VBrick\Presentations.
a. Right-click on the folder you just created and select Sharing and Security.
b. Click Share this folder, click Permissions, give Everyone Full Control, then click 

Apply and OK. (If the Share Name field is blank, type Presentations.)
c. On the Web Sharing tab, click Share this folder, and on the next window (click Edit 

Properties if necessary) click Read, Write, and Execute (includes scripts). Then 
click OK and OK to exit.

2. Add a new user with Computer Management.
a. Go to Start > Control Panel > Administrative Tools > Computer Management.
b. Click Local Users and Groups.
c. Right-click on Users and select New User.

Note The web server must be a standard Microsoft IIS web server that is configured to run 
ASP. The web server account used by VBPresenter should be a "virtual FTP 
account." If you need help, contact your web server administrator. You simply need a 
FTP account such that web pages placed in this account are visible as web pages 
from the server, that ASP is running, and that the FTP account has full read/write 
privileges.

Note When configuring an FTP account, the user name, the web and FTP virtual 
directory names, and the folder name where the uploaded presentations reside, 
must all have the same name. The following IIS configuration procedure is the same for 
all versions of VBPresenter.
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d. Create a user name (for example: Presentations) and set a password (for example: 
password). See note above: on Windows Server 2003, the user name must be the 
same name as the FTP virtual directory folder name.

e. Uncheck User must change password at next logon (recommended).
f. Check User cannot change password and Password never expires 

(recommended).
g. Click Create and then Close.
h. Select the Users folder and verify the new user was created.

3. Set the local path for the new user.
a. Right-click on user Presentations and select Properties.
b. On the Profile tab in the Home folder, set the Local path to the Presentations 

folder: for example: C:\Program Files\VBrick\Presentations and click Apply and OK.

4. Create a virtual directory on the Default FTP Site in IIS.
a. Go to Start > Administrative Tools > Internet Information Services (IIS) Manager.
b. In left panel, double-click on local computer and then again on FTP Sites.
c. Right-click on Default FTP Site and select New > Virtual Directory.
d. Run the wizard and create new virtual directory called Presentations. 
e. Set the path to C:\Program Files\VBrick\Presentations and click Next.
f. Set the permissions for this folder to Read and Write. Click Next and Finish.
g. Right-click on the newly created Presentations folder and select Permissions.
h. Click Add, type Everyone in the text box, and click OK.
i. Give Read and Write permissions to Everyone and click OK.

5. Configure the Default Web Site.
a. In left panel double-click on Web Sites.
b. Right-click on Default Web Site and select Properties.
c. On Directory Security tab, edit Authentication and access control, check Enable 

anonymous access, and click OK.
d. On Documents tab, set Enable default content page to include index.htm and 

index.asp and click OK. (If prompted, click OK. Do not select Inheritance 
Overrides.)

e. Double-click on the Default Web Site, then right-click on the Presentations folder 
and select Properties.

f. On the Virtual Directory tab, set the Local path to C:\Program 

Files\VBrick\Presentations, then click OK. (Note that the folder name, e.g. 
Presentations, must match the user name created in Step 1 above.)

g. Right-click on Presentations and select Properties.
h. In the Application name field, click Remove and then Create. 
i. In the Execute permissions field, select Scripts only. Then click Apply and OK.
j. Verify that the Presentations folder has an executable icon as shown below. If not, 

repeat Step 5. .
k. In left panel, double-click on local computer, then double-click on Web Service 

Extensions and verify that Active Server Pages are Allowed.

6. Close the window and you are finished configuring IIS for VBPresenter. As explained 
below, you will still need to configure VBPresenter for IIS.
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Your goal is to set up an FTP account on the Windows server such that when a user enters 
the username/password, they are placed in a folder that is published by the web server. If you 
create a folder called mystuff, and place mypage.htm in the folder, then the page should be 
viewable on the network via http://ipAddress/mystuff/mypage.htm. Once setup, you will use 
this username/password and base URL (in this example, the base URL is http://ipAddress/

mystuff) as the server URL in VBPresenter). If you record your presentation, you can place 
all of the files on the web server so that the WM stream will be delivered via HTTP 
progressive download.

Configuring VBPresenter for IIS
The following window (Figure 4) shows how to configure VBPresenter to use the web server 
FTP account (VBPresentations) you defined above. Note that the Username and Rmt 
Directory have the same name.

Figure 4.  Configuring VBPresenter for IIS
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Chapter 2

Using VBPresenter
Topics in this chapter

Before You Begin . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19
Uploading a Presentation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19
Testing Your Presentation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20
Viewing a Live Presentation. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20
Viewing a Recorded Presentation  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22
Using VBPresenter Tools . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23
Using VBPresenter Tools . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23
Recording a Presentation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31

Before You Begin

Setting Windows Media Player Options

As explained in Typical Configurations on page 37, VBPresenter works with either unicast or 
multicast streams. Multicast streaming is primary used in a Local Area Network or an 
enterprise environment. Multicasting is an efficient means of sending video over the LAN 
because the replication of the video stream is handled by the network equipment like routers 
and switches. Check with your network administrator to find out if your network is enabled 
for multicast. For a Windows Media multicast, the viewer must have certain multicast and 
security options enabled in their Windows Media Player. To set these options, go to Tools > 
Options and check that the Network and Security tabs are configured as shown below.
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Logging In

The login window is used to identify who is viewing your live presentation—it does not 
perform authentication or authorization. Note that you are not allowed to log in if the 
current number of users exceeds the value configured for Max Viewers in the setup program.

Presentation Title

The presentation title displayed in the VBPresenter viewer is derived from the first 
PowerPoint slide in the presentation–not from the file name. For example, the title "My 
Presentation" is derived from the Slide 1 text box. This is the Title Slide in the default 
PowerPoint template. Keep this title short (less than 50 characters) so that it does not extend 
beyond the video area of the VBPresenter page.

Asking Questions

Live presentations only. Viewers can submit questions at any time during a presentation. 
Simply type in your question and click Go. Submitted questions are only seen by the 
presenter; this avoids "chat" among your viewers. See Audience Questions on page 27 for 
more about his feature.

Viewing References

Presentations can include virtually any reference material. When creating a presentation, the 
author can select and upload reference material, for example PDFs, Word files, Excel 
spreadsheets, video files, Flash demos, etc. These reference materials are listed and can be 
viewed or downloaded by end users. This means you can use VBPresenter as a primary 
vehicle for training and information delivery. See Add References on page 30 for more about 
this feature.

Password Protection

You are prompted to create a password for the presentation when you upload your slides. If 
you configure a password, all end users will be prompted for that password before they can 
view a presentation. This feature can help to protect private or sensitive information in a 
presentation but should be used with care. It provides a reasonably good measure of 
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protection but will not protect mission-critical information against determined hackers. For 
higher security you can password-enable the directory on your web server or you can use the 
permissions features available with MCS.

Table 4.  Supported Features by Presentation Type

Uploading a Presentation
After you have created a PowerPoint presentation and are happy with the slides, the next step 
is to upload the presentation to your web server and go LIVE ONLINE in VBPresenter. This 
launches an online multimedia presentation with PowerPoint slides and live streaming video 
(see Figure 5). End users can view the presentation by clicking on an auto-generated URL 
contained in an e-mail or by using VBrick's MCS Portal Server.

To upload a presentation:

1. Open PowerPoint and launch the PowerPoint .ppt slide show you want to use in your 
presentation.

2. Optional. Click Add References to include related material.
3. Click LIVE ONLINE to launch the video stream.
4. Click Upload Presentation on the setup window to upload the slides to your configured 

web server.
5. Optional. Enter a password that end users must use to launch the presentation.
6. Optional. Verify that the upload was successful. See below Verifying the Upload.
7. Click the e-mail icon to notify viewers they are invited to view a live multimedia 

presentation. Modify the e-mail to indicate when the presentation will begin.
8. Optional. If you are using MCS as a web server, the MCS Portal Server can be configured 

to display live presentations on the Live Broadcasts page or stored presentations (that 
have been recorded and published) on the Video Library page. See "Rich Media 
Presentations" the Portal Server Admin Guide for more about how to configure for this 
functionality.

Live Presentation Recorded Presentation

Ask a Question X

Reference Material X X

View Thumbnails X

Audience Polling X X

Resizable Video X X

Note To avoid potential issues with browsers and hyperlinks, remove any leading or 
embedded spaces in your PowerPoint file name before uploading the presentation. 
Also avoid using animations, "builds," or other special effects. See PowerPoint 
Guidelines on page 36 for more information.
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Verifying the Upload

It is always a good practice to verify that your slides have uploaded successfully and your 
video is streaming from the VBrick. When an upload completes, you are prompted to view 
the uploaded presentation. Select Yes when prompted to view the uploaded live presentation.

Testing Your Presentation
It's always a good idea to test your audio, video, and slides locally before presenting to a live 
audience. This can help identify problems in advance and provide your viewers with an 
optimal viewing experience. For a successful presentation, there is no substitute for a 
thorough walk-through that can anticipate and address potential issues—particularly with 
your network. The best way to test what your viewers will actually see and hear is to have someone 
view your presentation from a separate desktop using Internet Explorer. This will test the 
presentation on your local network and/or over the public Internet if you are using a 
reflector. This method will provide a real-world test of your multimedia presentation in a 
simulated production environment.

Viewing a Live Presentation
There are various ways to view a live recorded presentation. If you are using MCS as a web 
server, the presentation will be displayed on the Live Broadcasts page with a special icon. 
You can also notify your viewers via e-mail or other means to view your presentation URL. 
Remember, the URL is the URL of your server and account followed by /PowerPoint name. 
When the viewer clicks on, or enters the URL, a window similar to the following will appear. 
(Note that the View Thumbnails option is only shown on recorded presentations.) Your 
slides will appear on the right and your live video on the left. You can submit questions at any 
time during a live presentation.

A simpler method is to self-test the audio and video using the Video Viewer icon on the 
VBPresenter toolbar. This is an easy way to check and adjust the audio and the video. When 
you click on the viewer, a preview window opens and you can check that you are properly 
framed and that the video is clear and sharp. To check or adjust the audio, unmute the sound 
on the viewer control panel and say a few words. Then wait for a few seconds (without 
speaking) until your voice is played back through the Windows Media Player. This is the 
audio your viewers will actually hear, and you can adjust your microphone as necessary until 
the audio quality is optimal. See Delivering Effective Presentations on page 35 for more 
about creating and delivering successful presentations.
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Figure 5.  VBPresenter Live Presentation

To view a live presentation:
1. Click on the hyperlink in the auto-generated e-mail. 
2. Optional. If you are using an MCS Portal Server, launch a live presentation by clicking on 

any presentation available on the Live Broadcasts page.
3. Optional. Enter the presentation password. This must be provided by an administrator.
4. When the VBPresenter window opens, wait a few moments until buffering completes 

and the video begins to stream.
5. Note that the PowerPoint slides are only displayed when the slide changes. For this 

reason a new viewer may not see any slides until there is an auto-refresh or a new slide.

Launching the External Viewer

Click on Resizable Video to launch the external viewer. This freezes the stream on the 
VBPresenter page and launches it in an external viewer window that you can resize or 
minimize. When you close the external viewer, the stream re-buffers and re-starts in 
VBPresenter.
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Figure 6.  Resizable Video Viewer

Viewing a Recorded Presentation
Once published, there are various ways to view the recorded presentation. If you are using 
MCS as a web server, the presentation will be displayed on the Video Library page with a 
special icon. You can also view the recorded presentation from VBPresenter using the 
Presentation Archive URL (see Publishing a Recorded Presentation on page 32) that was 
assigned when it was uploaded. It can also be viewed from an automatic program list (see 
Automatically Listing Recorded Presentations on page 33). A recorded presentation is similar 
to a live presentation except that you can use the NAVIGATE feature (see below) to advance 
the video to any point in the presentation.

When first launched, the video is downloaded into the player buffer and the download 
progress is shown beneath the player controls. Once the download is complete, you can 
advance to any point in the presentation. NAVIGATE and Download progress are only shown 
when you are viewing a recorded presentation. Click Resizable Slide Viewer to open a 
popup window showing the current PowerPoint slide. Use this window to resize the slide for 
better viewing.

Using a Streaming Server vs. Progressive Download

A streaming server is a dedicated device that responds to client requests in real time. Video 
from a streaming server is not downloaded to the Media Player—rather it is streamed and 
played at the same time. You should always use a streaming server for larger video files and/
or when you expect more that a few viewers. Progressive download is a way of delivering 
video that involves caching and playing the downloaded portion of a file while the remainder 
of the download is still in progress. Progressive download is "bursty" and the viewing 
experience is generally considered sub-optimal compared with video from a streaming server.
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Figure 7.  VBPresenter Recorded Presentation

To view a recorded presentation:

1. Paste the Presentation Archive URL into a browser. 
2. Optional. If you are using an MCS Portal Server, launch a stored presentation by clicking 

on any presentation available on the Video Library page.

Navigating a Presentation

The NAVIGATE button on the VBPresenter window is only displayed when you are viewing a 
pre-recorded presentation. After a stored presentation is downloaded to your machine, you 
can use this feature to quickly navigate to any point in the presentation.

Using VBPresenter Tools
When giving a live presentation, navigate your presentation normally using a keyboard or a 
mouse, or enter PowerPoint Slide Show mode and advance your slides as you would 
normally. As you change slides, the audience will follow along and the video and slides will 
always be in sync. You should generally avoid using a speaker phone during a live presentation. Any 
normal delay introduced by reflector server will conflict with the audio from the speaker 
phone.

Table 5.  VBPresenter Basic Functions

Function Description

VBPresenter Setup Use this window to enter configuration details about your web 
server and your VBrick appliance. Please review the requirements 
for each entry in the table below. Note: the setup option will not 
appear if the PowerPoint Add-In is configured by a config.txt file 
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Upload Now After setup, use this button to upload your presentation to your 
server. Depending on your connection speed and the size of your 
presentation, this may take several seconds or many minutes. If 
the presentation already exists, you will receive a warning. 
Remember, everything is based on the PowerPoint file name. If you want 
to keep a previously recorded presentation, you should use a 
different PowerPoint file name.

Send Email Use this button to tell your audience how to tune in to a 
presentation. The e-mail automatically contains URLs for both 
Internet (unicast) viewers and local (multicast) viewers. You 
should edit the message to suit your needs (for example, include a 
presentation start time, and delete the multicast address if not 
being used.

Video Viewer When you are online, press this button to view your live video 
stream. Depending on your VBrick type, configuration, and/or 
server setup, there may be a significant video delay. This self view 
feature allows you to ensure you are centered in the camera, have 
adequate lighting and audio levels, etc. Close the viewer when you 
are satisfied with your appearance—this is exactly what your 
audience will see.

Select Select ONLINE/OFFLINE to turn streaming video on or off. Turn 
off when you are not doing an online presentation or when you 
want to change slides without showing them online.

Record Select START/STOP to begin or end a recording. You must be 
online in order to record a presentation.

Show Web Page This is the "Guided Web Browsing" feature. Type in a valid URL 
and click Go to launch a web page that replaces the current slide 
in VBPresenter. Close the window to return to the presentation.

Audience Poll Use this feature to conduct a realtime multiple-choice audience 
poll (WM appliances only).

Show Questions Opens a new window and shows all users who are currently 
logged in and any questions that have been submitted.

Send Message Lets you send a text message, for example a startup banner, to 
anyone logging in to a presentation.

Publish Recorded 
Presentations

Use this function to publish your recorded presentation to your 
web server. The same URL that was used to view your live 
presentation is used to view your recorded presentation. Be 
careful not to upload a new presentation with the same name or 
you will overwrite the existing presentation.

Add References When creating a presentation, the author can select and upload 
reference material, for example PDFs, Word files, Excel 
spreadsheets, video files, Flash demos, etc.

Function Description
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Video Viewer

Figure 8.  Video Viewer

Send Message

This feature lets you send text messages that are useful for startup banners or preliminary 
information. You must be online to send a message. If you send a message during a 
presentation, the message will replace the slide currently being displayed.

Video Input Select Video1 or Video2 (or the configured name) during a live 
presentation to switch between Composite and S-Video. This 
means you can use two cameras during a presentation and switch 
between the primary camera and a secondary camera (or other 
video source).

Help Use this function to display the online help.

Click on the video camera icon to launch the internal video viewer. This is an easy way to 
check the video or to launch a presentation if your PowerPoint slides have already been 
uploaded. It is important to note that the Viewer Video source and the Recording Video 
source may be the same—but can also be different. For example, if you are using a reflector 
server or using multicast, you may get a better recording result by recording directly from the 
VBrick rather than from the URL used by your viewers. The content is always the same but 
when you record from a reflector over the public Internet, there is always the chance for 
network delay and other issues. In most cases, the VBrick generally provides a superior 
recording solution. See the VBPresenter Setup Window on page 6 for more about 
configuring a Video Viewing URL vs. a Video Recording URL.

Monitor Viewer Video Shows the video your viewers are seeing.

Monitor Recording Video Shows the video you are recording with low 
delay and no audio.

Function Description
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Show Web Page

Select the Show Web Page button to open a window with a browser. Type in any web page 
URL (default is http://www.vbrick.com) and press Go. Your selected web page will be 
displayed and your viewers will be directed to the same web page. Navigate your selected web 
page by clicking on any hyperlinks, and your viewers will automatically follow you (Note: Web 
pages that use special Javascript functions and popups cannot be used). Guided web 
browsing (also called "follow-me" browsing) adds additional rich media to your presentation. 
For example, you can give a tour of your web site or point your viewers to web pages that you 
have constructed. You can even launch a web page with embedded video or Flash animations, 
thus giving your audience a rich multimedia experience.

Note that if you publish your presentation on a CD, any web pages you have placed in your 
presentation will only display if the PC used for viewing is connected to the public Internet 
(otherwise, the viewer will get a "page not found" error. Also, you should use care with your 
URL selection because public web URLs may change over time (just like your web browser 
bookmarks can become out of date).

If your PowerPoint slide notes have a URL listed in the notes panel, the Show Web Page icon 
will automatically launch that page. The PowerPoint note URL should take the following 
form:

**URL http://fullpathname.com

Enter this URL in the "notes" panel at the bottom of the window (see Figure 9). You may 
have to resize the window to see this panel. This feature is convenient, especially when you 
wish to incorporate your own web page content into your presentation. The web page may 
contain Flash, audio, video, or any other feature or function that can be displayed in Internet 
Explorer over the network. For educators, the URL may also point to "Blackboard," 
"SharePoint," or other web collaboration tools.
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Figure 9.  VBPresenter "Notes" Panel

The PowerPoint "notes" panel supports a variety functions as shown in Table 6. These 
functions are described in detail elsewhere in the text.

Table 6.  PowerPoint Notes Tags

Audience Questions

Your audience can ask question at any time during a live presentation by clicking Ask a 
Question. As a presenter, you can view these questions by pressing the Show Questions 
button on the VBPresenter toolbar. This window shows all users who are logged on or off 
and any questions that have been submitted. The audience member's name is displayed with 
an icon next to the question. The Audience Questions display is auto refreshed each time 
someone asks a question. This means you can leave the window open to see and answer new 
questions in real time. Alternatively, tell your audience that they may ask questions at any time 
and that you will answer them at the end of your presentation. Audience questions are 
supported in the following scenarios:

Function Tag

Show Web Page **URL http://fullpathname.com

Audience Polling **QThis is the question.
**A1 This is answer 1.
**A2 This is answer 2.
**A3 This is answer 3.
**A4 This is answer 4.
**A5 This is answer 5.

Show Poll Results **SHOWPOLL

Full Screen Video **FULLSCREENVIDEO
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• PowerPoint Normal view only (not Slide Show view).
• Live presentations only (not recorded presentations).

Figure 10.  Login Status and Audience Questions

Questions can also be viewed at the same URL as the current presentation plus "/

history.asp". So, if your presentation is at http://mysite/myshow, audience questions can be 
viewed at http://mysite/myshow/history.asp. You can also save login status and questions to 
a .txt file for future reference. The Save History button saves the login/logout history and all 
questions that were asked during the presentation. Save Viewer List saves a list of all viewers 
who logged in.

Audience Poll

Conducting a Poll
On the toolbar, select Audience and then Poll Audience to conduct a realtime multiple-
choice poll of your viewing audience. You can type in a question and up to five answers. If 
you type the questions and answers in realtime, your audience will have to wait while you do 
so. If you type the questions and answers in advance, in the notes pane at the bottom of the 
PowerPoint slide window, the polling form is automatically populated when you click 
Audience Questions and you can quickly send the poll. The question is limited to 100 
characters, and each answer is limited to 30 characters, but the total of the question and 
answers cannot exceed 186 characters. You must use the following format, with leading 
asterisks, in the PowerPoint notes pane (see Figure 9).

**Q This is the question.

**A1 This is answer 1.

**A2 This is answer 2.

**A3 This is answer 3.

**A4 This is answer 4.

Note The global.asa file includes a profanity filter that prevents viewers from using 
objectionable words in questions. This file is created in the web server Presentations 
folder when you publish a presentation. To filter objectionable words, simply open 
the file with an editor, uncomment the filter, and modify the word list.
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**A5 This is answer 5.

When you are finished creating the poll (by completing the window manually or by using the 
notes pane in PowerPoint as explained above), click Send Poll to send the questions and 
answers to your audience in real time. After you press Send Poll, you are ready to receive the 
realtime poll results on the following screen.

Responses are shown in realtime and in graphical form each time you press the Get 
Responses/Refresh button. The results show the number of responses for each answer and 
the total number of responses. You can save your poll results to a file (web page) on your 
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computer by selecting Save Poll Results. The poll results are saved on your computer in the 
same folder as your slides.

Showing Live Poll Results
When giving a live presentation, enter the following command in the notes area to share the 
poll results with the entire audience. Use this feature with care. It displays the results of all 
polls for the current presentation.

**SHOWPOLL

Showing Stored Polled Results
Published presentations can include multiple-choice tests. The test results are automatically 
tabulated and include the optional entered name of each viewer. The ability to get poll/test 
results from stored presentations means that you can publish a training presentation, give 
students a special name for viewing it, and get that student's time-stamped test results at any 
time. Similarly, in a marketing program, you can continuously collect and tabulate the results 
of customer surveys. Poll results from stored presentations are available online by accessing 
getpoll.asp. This page is saved in the same directory as your published presentation, for 
example:

http://serverIPaddress/remotedirectory/original_ppt_name/getpoll.asp

Figure 11.  Sample Poll Results

Add References

Use this window to add or remove reference material that will be available to end users. You 
can select and upload reference material, for example PDFs, Word files, Excel spreadsheets, 
video files, Flash demos, etc. Simply browse to the items stored anywhere on your network 
and populate the window. Since each upload removes the contents of the previous upload be 

Note You may want to include a page in your PowerPoint presentation with text that says 
Please Take A Poll and include the poll questions and answers on this page's notes 
area. When the person giving the presentation reaches this page, they will know that a 
poll is available. Audience polling is very useful to ensure your audience is paying 
attention and is grasping difficult concepts. If the results of your poll indicates a lack 
of understanding, you can quick backtrack and cover the information in more detail.
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sure to upload all of your items at once. After you click Upload, confirm the action and wait 
for an Upload Complete message before closing the window.

Displaying Full Screen Video

Enter the following command in the notes panel to hide the PowerPoint slide and switch the 
video panel only on each viewers monitor to full screen. It stays at full screen until you select 
another slide. In full screen mode, the slide is shown as an insert.

**FULLSCREENVIDEO

Recording a Presentation

• For best results, you should linger on the last slide of any presentation for a few 
moments after you are done to accommodate the delay in the video and ensure your last 
slide is recorded. 

• The built-in recorder is limited to recording three hours. If you plan to record a 
presentation that is longer you should break up the PowerPoint into multiple 
presentations (e.g. mypresentation1.ppt, mypresentation2.ppt, etc.). Longer 
presentations may be too large to manage as a single file.

• You, or someone else, may also record your live video presentation complete with all 
slides using VBrick's StreamPlayer Plus. If you wish to integrate such an 
independently-recorded WM video file into your presentation, be sure to name it the 
same as your PowerPoint file. Give your live presentation using VBPresenter while you 
record the live video using StreamPlayer Plus. When you are done with your live 
presentation, start again with the same PowerPoint and record a new one-minute 
presentation using VBPresenter and publish it (this ensures all of the archive viewing 
pages are created). Next, log into your server via the Manage button and replace the 
one-minute file with your larger file. This technique is useful if you create a second 
(backup) copy of the live presentation video which is recorded via local multicast. The 
VBPresenter recording is done using the same URL that your viewers are using and may 
be subject to Internet issues, while your local multicast is likely very reliable.

The following paragraphs provide useful information about recording and viewing 
presentations. Remember, you must be LIVE ONLINE before you can record a presentation. 
Select Record START in the toolbar, and confirm, to begin recording. Actual recording 
begins a few seconds after you press START when the red "record" icon is shown on the 
toolbar.



32 © 2008 VBrick Systems, Inc.

• The recorded video file will have the same name as the PowerPoint presentation, and the 
file will be located in a folder with the PowerPoint presentation name. For example, if 
your PowerPoint file is called myshow.ppt and it is in My Documents then the video file 
will be My Documents/myshow/myshow.wmv.

• You can view your presentation, after publishing, by right-clicking on the Presentation 
Archive URL at the bottom of the "publish" window. You can also click Make Local File 
and view the recorded presentation by opening play.htm (which is located in the same 
folder as the PowerPoint presentation) in Internet Explorer. Tip: you can zip the entire 
folder and send it to someone or put it on a CD. They need only click on play.htm to 
view the presentation. You can also upload the entire folder to a web server. Viewers can 
view your recorded video presentation via "progressive download" from any web 
server—they just enter (or click on your hyperlink) the URL to the folder name.

• The recorded file will contain references to all slides as they were presented. This means 
that you can instantly post recorded presentations on a video server for instant video on 
demand.

• Your Video Recording URL (see Selecting a Video Viewing URL on page 10) must be set 
correctly. It is often the same as the Video Viewing URL, but you can set it to a local 
multicast, or set it to your local VBrick server while your Video Viewing URL is the URL 
of a reflector server.

Publishing a Recorded Presentation

You can instantly publish your recorded presentation to your web server or to a streaming 
server by selecting Publish Recorded Presentation on the VBpresenter toolbar. When the 
dialog window (below left) is displayed, click Upload to actually publish your presentation to 
the web server. You can launch the presentation after an upload by right-clicking on the 
Presentation Archive URL at the bottom of the window. Click Make Local File to copy the 
presentation files to the same local folder as your PowerPoint presentation. To play a 
presentation locally, navigate to the corresponding local folder and click play.htm.

The upload function will copy your recorded video to your web server or streaming server 
and will create a specially formatted viewing page on your web server (see Automatically 
Listing Recorded Presentations below). Viewing the recording will occur via "progressive 

Note The Make Local File functionality is supported on WM appliances only.
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download" from your web server or via a stream from your streaming server. When you 
publish your recorded presentation, viewers will see exactly the same presentation that you 
gave live, except they cannot ask questions. They can rapidly navigate by viewing and clicking 
View Thumbnails after the progressive download is complete.

For example, if you give a live presentation using myshow.ppt, your live URL will be 
/myshow. If you record this live presentation and publish it, the recorded presentation URL 
will be /myshow. If you upload a "new" presentation with the name myshow, you will replace 
any previous uses of this presentation name (either live or stored). To avoid any confusion, 
always rename your PowerPoint file to something meaningful and unique prior to uploading.

Re-Publishing a Recorded Presentation
If you delete the presentation from your server and if it still exists on your computer, you can 
publish it again. Simply open the same PowerPoint file, upload the presentation, then publish 
it. Video files are typically very large and you will need to be patient during the upload. Be 
sure you have adequate disk space on your web server before you begin. The viewing URL will 
be displayed after upload is complete.

Automatically Listing Recorded Presentations

A listing of all of your published presentations is automatically available from your web 
server. Presentations are automatically published to the root level of the server. To access the 
archive list, simply enter http://serveraddress/remotedirectory in your browser. For example 
if your sever is myserver and your directory is mydir then the viewing URL is http://

myserver/mydir. Live presentations do not appear in this list (for privacy). You can remove a 
stored presentation from the list, without deleting it, by logging in to your server and deleting 
the file called 1.stm from the presentation folder. As shown below, a thumbnail of each 
presentation is shown on the left and the title and date are shown on the right. Click on the 
thumbnail or the title to launch the presentation. Click on Presentation Title or Date 
headings to sort the presentations. This page provides an easy way to view and manage your 
presentations.

Note When you publish your recorded presentation, the same URL that was used to view 
your live presentation is used to view your recorded presentation. This is convenient 
in most cases. However, be careful not to upload a new presentation with the same 
name after you have published your recorded presentation. If you do, you will replace 
the recording with your new live presentation.
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Figure 12.  Auto-Generated "Presentations" Page
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Delivering Effective Presentations

Basic Guidelines

• A WM appliance running supports widescreen mode. If you connect a widescreen video 
camera to the appliance, viewers will see widescreen video on their PCs. This is ideal for 
showing two or more presenters, or a panel discussion, at the same time.

• The URL of your presentation is the name of your PowerPoint file. Keep your 
PowerPoint file names short and easy to enter. For example, change my sales 

presentation for january.ppt to something like JanuarySales.ppt. Remember, your 
presentation is listed using the PowerPoint file name so you will want the file name to be 
informational.

• To avoid potential issues with browsers and hyperlinks, remove any leading or embedded 
spaces in your PowerPoint file name before uploading the presentation.

•  You may wish to remind viewers to disable any popup blockers, and/or to configure 
their Internet Explorer browser to allow popups from your server.

• The first slide in your presentation may not be displayed if you are already online. We 
recommend that when you start your presentation you go Online, or that you advance to 
slide two and then go back to slide one. It is a good idea to duplicate the "first slide" in 
your presentation so that slide one and slide two are identical).

• After you have uploaded a presentation, you do not need to upload it again unless it has 
changed. The VBrick PowerPoint Add-In will automatically select the current 
presentation. This means that you can switch PowerPoint files, even in the middle of a 
live presentation as long as the presentation has been previously uploaded, and your 
audience will always be seeing the right slides (as long as the PowerPoint file you switch 
to is the one you have previously uploaded). However, you must not switch presentations 
if you are recording.

• Use as much light as possible! All video looks better and more professional when it is 
well lit and you use a good quality camera.

•  Unless you have a local audience, look at the camera as much as possible.
•  When you look to your left, your audience will see your head turn toward the displayed 

slide and you can use this fact to enhance the viewing experience. Your audience will 
naturally follow your eyes. Rather than having your computer screen in front of you, 
place it to your left. Look at the camera most of the time—when you turn your head to 
the left to view a slide, your audience will see you looking in the correct direction. This is 
often more pleasing than seeing you look down toward your computer.
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•  You can switch the video input to your VBrick by clicking the Composite or S-Video 
buttons on the Setup window or by selecting Video 1 or Video 2 on the toolbar. This is 
very useful for a professional appearance: Your camera might be connected to the 
VBrick composite input and some other video source (e.g. a DVD player) might be 
connected to the S-Video input and you end your presentation by switching to some live 
video banner. Switching inputs during your presentation can also be used to show your 
audience other video sources. Note that audio does not switch and this technique 
presupposes that your second video source has no audio, or that the audio is mixed with 
your microphone audio.

• Use a good quality microphone and preamplifer. The VBrick accepts "line level" audio 
in, such as the output of a wireless microphone receiver or the "line level" output from 
your camera, VCR, DVD player, TV tuner, etc. You can typically use your camcorder 
with its built-in microphone. Removing the tape will often allow the camcorder to 
operate without automatically shutting down after a few minutes.

• Delete old presentations from your server. You will want to delete old presentations to 
save disk space, or to ensure privacy. Remember, if you upload presentation "A," and 
then upload presentation "B," a viewer can see your current live presentation by viewing 
either "A" or "B." If you record presentation "A" and then publish it, then a viewer of 
presentation "A" cannot see your current live presentation. If you are concerned about 
privacy, follow this rule: delete any presentation that you have not recorded and published.

•  Again, your PowerPoint file name is the key. If you are concerned about privacy, use an 
obscure name. Someone might guess a presentation named sales, but they would likely 
not be able to guess sales_xy84q.

•  If you are sending your video via multicast, you should disable the VBrick Announce 
SAP in IWS to provide better privacy of your live video. To do this, launch IWS, then go 
to Configuration: Encoder > Announce (SAP) and disable Transmit.

• You cannot right-click to copy a line from VBPresenter add-in. To copy a URL or other 
text, highlight the text and then use Ctrl-C and Ctrl-V to copy and paste.

• The presentation title displayed in the VBPresenter viewer is derived from the first 
PowerPoint slide in the presentation–not from the file name. For example, the title "My 
Presentation" is derived from the Slide 1 text box. This is the Title Slide in the default 
PowerPoint template. Keep this title short (less than 50 characters) so that it does not 
extend beyond the video area of the VBPresenter page.

PowerPoint Guidelines

There are no special requirements for your PowerPoint presentation and you can use existing 
PowerPoint files. However, the following guidelines will generally provide the best results:

• Do not use PowerPoint animations, audio or video, or other special features. If the slide 
has a "build" or animation, only the fully built slide will be displayed.

•  To conduct "builds" (where a new line is added to a bullet list each time you advance the 
presentation), use multiple slides. For example, create a slide with four lines. Copy this 
slide three times and delete line 4 from the third slide, delete lines 3 and 4 from the 
second slide, and delete line 2, 3 and 4 from the first slide. These four slides will now 
"build" as you go through your presentation.
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Managing Bandwidth Issues
A VBrick WM appliance is a server and can simultaneously deliver multicast to any number 
of viewers, push to a server for bandwidth scale, and deliver live video directly to 200 viewing 
clients via unicast up to about 50 Mbps. For delivering video to people outside your local area 
network (e.g. on the public Internet), you need two things: sufficient bandwidth (if you are 
streaming at 200 Kbps, you need 200 Kbps times the number of viewers), and your viewers 
need to be able to reach your source VBrick. Both of these typically mean you will configure 
the VBrick for an "outside" IP address. A VBrick that is outside your LAN and has an 
Internet address can be "reached" by global Internet viewers. But if a VBrick is "outside," 
then each potential "inside" local viewer would need to use your Internet access connection 
to view your video. With even a handful of "inside" viewers, this could easily saturate your 
Internet access connection, causing an unsatisfactory experience. While the source VBrick 
could also multicast, if it is "outside" your LAN then the multicast would not typically appear 
on your "inside" network.

To address this issue:

1. Place the source VBrick inside your network.
2. Configure your VBrick to multicast. Your live video can now be viewed within your LAN 

without bandwidth concerns.
3. Configure your VBrick to send live video to an "outside" reflector server. For Windows 

Media, this would be a Windows Media Server Since total Internet access bandwidth may 
also be an issue, you might chose to use a reflector service such as PowerStream for your 
Internet viewers.

Your outside Internet audience will view your presentation via http://yourserver/

PowerPointName, and your inside viewers will view via bandwidth-saving multicast via http://

yourserver/PowerPointName/multicast.htm. These addresses are automatically entered into 
an e-mail by the VBPresenter PowerPoint Add-In.

Typical Configurations

Using Unicast

The following drawing illustrates basic operation. The VBPresenter PowerPoint Add-In 
creates slides and uploads them to a web server. A VBrick delivers video over the public 
Internet to viewers. The video includes metadata that draws the slides from the web server as 
needed. In this case, the VBrick must be "outside" a LAN (i.e. it must have a public Internet 
address) and it can support up to 200 viewers.

Figure 13.  Typical Unicast Configuration
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Using Multicast

The following drawing illustrates multicast operation. In this case, the VBrick is also sending 
video via multicast on the local area network. Multicast has the advantage of not using any 
Internet access bandwidth for video, although the slides are delivered over the public Internet 
access connection (this is not a problem because the images are small). An important concept 
is that the LAN multicast and the Internet multicast occur simultaneously.
 

Figure 14.  Typical Multicast Configuration

Using a Reflector Server

The following drawing illustrates operation with a reflector server. In this case, the VBrick is 
sending a stream to a reflector server, perhaps a server with high bandwidth Internet access, 
and the reflector is sending the video to viewers. In this case, the number of viewers is equal 
to the capacity of the reflector. Moreover, the VBrick may be located virtually anywhere, 
including "inside" your network (e.g. in your office). It is also worth noting that reflector 
service billing is typically based on GBs of data transferred. The longer your presentations 
are streamed, the more charges you will incur.

Figure 15.  Typical Reflector Configuration
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Overview
VBrick's EtherneTV Portal Server (MCS) can display live and stored rich media presentations 
created by VBPresenter. Live VBPresenter presentations are available for viewing from the 
Portal Server Live Broadcasts page; stored presentation are available from the Video Library 
page (and have a special icon). Like other content, rich media presentations can only be seen 
by those Portal Server viewers who have appropriate permissions. Before you can use 
VBPresenter with MCS, certain configuration steps are required on the Portal Server side. 
Once these steps are done, you can use the native functionality in VBPresenter to make live 
or stored presentations automatically available on the Portal Server. See "VBPresenter" in the 
Portal Server Admin Guide for an explanation of how to create a "presentation user" in MCS. 
This user is associated with VBPresenter and has specific permissions on the Portal Server.

Configuring a Web Server
Use one of the following procedures depending on whether which version of the ETV Portal 
Server you are using. Note that the Portal Server typically includes both server hardware and 
software but is also available as a software-only product. Web server configuration, as 
explained below, is the same regardless of which version you purchase.

Using MCS v4.1 as a Web Server

When installing a Portal Server (v4.1 or higher) on Windows 2003 Server, if a D: drive is 
present, a virtual directory is auto-created D:\VBrick\Presentations (for live presentations) and 
at D:\VBrick\MCSPresentations (for stored presentations). If a D: drive is not present, a virtual 

Note If you are using the ETV Portal Server to host VBPresentations, VBrick 
recommends upgrading to ETV Portal Server v4.1 or above. Portal Server v4.1 is 
easier to install and upgrade and lets you store presentations on the D: drive. If you 
previously configured MCS v4.0 using the default values suggested in the 
configuration procedure (see Using MCS v4.0 as a Web Server), VBPresenter will 
continue to work after an upgrade to v4.1. If however you used different folder 
names, for example, you will have to reconfigure the web server as explained in 
Upgrading from MCS 4.0 to 4.x.
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directory is auto-created at C:\Program Files\VBrick\MCS\Presentations (for live 
presentations) and at C:\Program Files\VBrick\MCS\MCSPresentations (for stored 
presentations).

MCS v4.1 automatically configures a web server for VBPresenter during software installation. 
It creates a user (Presentations), sets a local path, and performs various other configuration 
tasks. After installing the Portal Server software, VBrick strongly recommends you change 
the password (default = vbrick_86) for the Presentations user as a standard security 
precaution. Do not change the user name.

To change the password for the Presentations user:

1. Go to Start > Control Panel > Administrative Tools > Computer Management.
2. Click Local Users and Groups.
3. Right-click on user name Presentations and select Set Password.
4. Enter a new password and confirm.
5. Then right-click and select Properties.
6. On the General tab, uncheck User must change password at next logon 

(recommended).
7. Check User cannot change password and Password never expires (recommended).
8. Then click OK and Close.
9. To complete the VBPresenter setup, see Configuring MCS for VBPresenter on page 42 

and Configuring VBPresenter for MCS on page 43.

Using MCS v4.0 as a Web Server

VBrick MCS Portal Server runs on a standard Microsoft web server (Windows Server 2003) 
and is an appropriate server to use for your live presentations. You will need to set up an FTP 
account on the server. You cannot use the default MCS FTP account because it points to 
video "ingestion" for a VOD server. The following example shows how to configure MCS as 
a web server.

To configure MCS as a web server for VBPresenter:

1. Add a new user with Computer Management.
a. Go to Start > Control Panel > Administrative Tools > Computer Management.
b. Click Local Users and Groups.
c. Right-click on Users and select New User.
d. Create a user name (for example: Presentations) and set a password (for example: 

password). The user name must be the same name as the FTP virtual directory 
folder name.

e. Uncheck User must change password at next logon (recommended).
f. Check User cannot change password and Password never expires 

(recommended).
g. Click Create and then Close.
h. Select the Users folder and verify the new user was created.

Note When configuring an FTP account, the user name, the web and FTP virtual 
directory names, and the folder name where the uploaded presentations reside, 
must all have the same name.
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2. Set the local path for the new user.
a. Right-click on user Presentations and select Properties.
b. On the Profile tab in the Home folder, set the Local path to the Presentations 

folder: for example: C:\Program Files\VBrick\MCS\Presentations and click Apply and 
OK. (Note that this folder is automatically created during MCS installation.)

3. Set permissions for the Presentations folder in Windows Explorer.
a. Go to C:\Program Files\VBrick\MCS\Presentations.
b. Right-click and select Sharing and Security.
c. Click Share this folder, click Permissions, give Everyone Full Control, then click 

Apply and OK. (If the Share Name field is blank, type Presentations.)
d. On the Web Sharing tab, click Share this folder, and on the next window (click Edit 

Properties if necessary) click Read and Write. Then click OK and OK to exit.

4. Modify the Presentations virtual directory in IIS.
a. Go to Start > Administrative Tools > Internet Information Services (IIS) Manager.
b. In left panel, double-click on local computer and then again on Web Sites.
c. Double-click on Default Website, then right-click on Presentations and select 

Properties.
d. On the Directory Security tab, click the Edit button under Authentication and 

access control and verify that Enable anonymous access is checked. 

5. Create a virtual directory on the Default FTP Site in IIS.
a. Go to Start > Administrative Tools > Internet Information Services (IIS) Manager.
b. In left panel, double-click on local computer and then again on FTP Sites.
c. Right-click on Default FTP Site and select New > Virtual Directory.
d. Run the wizard and create new virtual directory called Presentations. 
e. Set the path to C:\Program Files\VBrick\MCS\Presentations and click Next.
f. Set the permissions for this folder to Read and Write. Click Next and Finish.
g. Right-click on the newly created Presentations folder and select Permissions.
h. Click Add, type Everyone in the text box, and click OK.
i. Give Read, Write, Read & Execute, and List Folder Contents permissions to 

Everyone and click OK.

6. In IIS, double-click on Web Service Extensions and verify that Active Server Pages are 
allowed.

7. Close the window and you are finished configuring a web server. To complete the 
VBPresenter setup, see Configuring MCS for VBPresenter on page 42 and Configuring 
VBPresenter for MCS on page 43.

Your goal is to set up an FTP account on the Windows server such that when a user enters 
the username/password, they are placed in a folder that is published by the web server. If you 
create a folder called mystuff, and place mypage.htm in the folder, then the page should be 
viewable on the network via http://ipAddress/mystuff/mypage.htm. Once setup, you will use 
this username/password and base URL (in this example, the base URL is http://ipAddress/

mystuff) as the server URL in VBPresenter). If you record your presentation, you can place 
all of the files on the web server so that the WM stream will be delivered via HTTP 
progressive download.
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Configuring MCS for VBPresenter

Configuring an MCS FTP User Account

The Portal Server's FTP User Name and FTP User Password must be set in the Admin 
console (Global Settings > Global Assignments) to the values that are configured in IIS. 
When a client logs on to the Portal Server's FTP account (for example from a Command 
Prompt window), this combination of FTP user name and password must place the user into 
the FTP root directory of the Portal Server. (This is not the same as the Presentations 
directory. The Presentations directory is a virtual directory in IIS. This directory is the root 
folder for live presentations only.) There is an MCS directory at the FTP root directory. Note 
that the entries made in the Admin console are stored in the Portal Server and do not actually 
configure IIS. These values must reflect what IIS has been configured for.

Configuring an MCS Presentation User

Perform the following configuration one time only in MCS so that VBPresenter can access the 
Portal Server. These steps will create a pseudo VBPresenter user who is associated with the 
authoring tool and has specific permissions on the Portal Server.

To create a presentation user:

1. Open the Admin Console and go to Users.
2. Add a user name (for example PresentationUser) and give this user the following 

permissions:
a. Add/Modify Live Channel Privileges – check the appropriate channels.
b. Add/Modify Live Programs Privileges – check the appropriate programs.
a. Allow Access to Specific VOD Servers – check the appropriate servers.
b. Allow Access to Specific VOD Content – check the appropriate folders.
c. Allow Content Publishing – check the appropriate folders.

3. Go to Global Settings > Global Assignments > Assign Presentations, select the user 
you created above (for example PresentationUser) as the New Presentations User, then 
click Submit. (Note that the Presentations Directory field in Portal Server v4.0 refers to 
the folder name under C:\Program Files\VBrick\MCS. If necessary, enter the folder name 
only in this field. Do not enter the complete path.)

Configuring for Live Presentations

The following steps must be performed to configure the Portal Server for each live 
presentation.

Note The MCS setup program creates an additional user name and password with an FTP 
Home directory in the Live Presentations folder on the MCS server. This User 
Name (Presentations) and password (vbrick_86 in MCS 4.2; Presentations in MCS 
4.2.1) are used in the FTP/Web Server section of the VBPresenter Setup window (see 
Figure 16).

Note In the ETV Portal Server v4.1, the Presentations directory is a virtual directory in 
IIS. This directory is the root folder for live presentations only. See the v4.1 Portal 
Server Admin Guide for more information.
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To configure the Portal Server for a live presentation:

1. Go to Global Settings > Program Names and add a program name (for example Live 

Presentation). Then use this same name in the MCS Program Name field in VBPresenter. 
This is the title that will be displayed on the Live Broadcasts page during a presentation.

2. If necessary, give your end users access to this live presentation. Go to Users > Add/
Modify Live Channel Privileges and select this Program Name.

Configuring for Stored Presentations

There is no additional configuration for stored presentations.

Configuring VBPresenter for MCS
When you are done, go to VBPresenter and configure the FTP server you defined above as 
shown in Figure 16. You may need to create a Presentations folder on the FTP/Web Server 
for your published presentations if not already present.

Figure 16.  Configuring VBPresenter for MCS

Hint To pre-configure a presentation, create a Program Name in advance on the Portal 
Server and assign Live Channel Privileges to users. Then use the same name in the 
MCS Program Name field in VBPresenter when giving the presentation. The MCS 
Program Name will be available on the Live Broadcasts page for any users who have 
permissions to view that channel

IP or Host MCS IP address or host name.

Username Default = Presentations. This user is created by MCS and used by 
VBPresenter to place content in the Presentations directory of MCS. 
(It is a Windows account user with a Home directory in the 
Presentations folder of the MCS server).
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Upgrading MCS
If you are using VBPresenter with MCS 4.0, you can use the following procedure to upgrade 
to MCS v4.x without affecting your existing presentations (4.x is 4.1 or higher).This 
procedure will preserve your existing presentations and let you create new ones with your 
existing file system and web server configuration. (Note that you will need to restart any live 
presentations currently in progress.)

Upgrading from MCS 4.0 to 4.x

If you are using the VBrick ETV Portal Server v4.0 to host your presentations, VBrick 
strongly recommends upgrading to ETV Portal Server v4.x. Portal Server v4.x is easier to 
install and upgrade and lets you store presentations on the D: drive for greater flexibility. If 
you installed VBPresenter with MCS 4.0, your live presentations will continue to work after 
upgrading to v4.x and will be saved on the C: drive. If a D: drive is present, live presentations 
will remain on the C: drive. Use the following procedure only if you want to move your live 
presentations to the D: drive. 

Stored presentations will not automatically work. You must manually copy any stored 
presentations from C:\Program Files\VBrick\MCS\MCSPresentations to 
D:\VBrick\MCSPresentations. No other configuration is required for stored presentations.

To move your live presentations from the C: drive to the D: drive:

1. Create the folder D:\VBrick\Presentations.
a. Go to Start > Control Panel > Administrative Tools > Computer Management.
b. Click Local Users and Groups.
c. Click on Users and in the right panel right-click on the Presentations user and select 

Properties.
d. On the Profile tab in the Home folder, set the Local path to the Presentations 

folder: for example: D:\VBrick\Presentations and click Apply and OK.
e. Go to C:\Program Files\VBrick\MCS\Presentations.
f. Right-click and select Sharing and Security. On the Sharing tab, select Do not 

share this folder.
g. On the Web Sharing tab, select Do not share this folder, and click OK.

2. Set permissions for the Presentations folder in Windows Explorer.
a. Go to D:\VBrick\Presentations.
b. Right-click and select Sharing and Security.
c. Click Share this folder, click Permissions, give Everyone Full Control, then click 

Apply and OK. (If the Share Name field is blank, type Presentations.)
d. On the Web Sharing tab, click Share this folder, and on the next window (click Edit 

Properties if necessary) click Read and Write. Then click OK and OK to exit.

3. Modify the Presentations virtual directory in IIS.
a. Go to Start > Administrative Tools > Internet Information Services (IIS) Manager.

Password Default = vbrick_86

Rmt Dir Presentations

URL MCS IP address or host name/Presentations. For example:
http://<ipaddress or host name>/Presentations.



VBPresenter with MCS

VBPresenter User Guide 45

b. In left panel, double-click on local computer and then again on Web Sites.
c. Double-click on Default Website, then right-click on Presentations and select 

Properties.
d. On the Directory Security tab, click the Edit button under Authentication and 

access control and verify that Enable anonymous access is checked. 

4. Modify the Default FTP Site in IIS.
a. Go to Start > Administrative Tools > Internet Information Services (IIS) Manager.
b. In left panel, double-click on local computer and then again on FTP Sites.
c. Right-click on Presentations and select Properties.
d. On the Virtual Directory tab, set the path to D:\VBrick\Presentations and click OK.
e. Right-click on the Presentations folder and select Permissions.
f. Click Add, type Everyone in the text box, and click OK.
g. Give Read, Write, Read & Execute, and List Folder Contents permissions to 

Everyone and click OK.

5. In IIS, double-click on Web Service Extensions and verify that Active Server Pages are 
allowed.

6. Reboot the server.

7. Close the window and you are finished configuring a web server. To complete the 
VBPresenter setup, see Configuring MCS for VBPresenter on page 42 and Configuring 
VBPresenter for MCS on page 43.

Using VBPresenter with MCS

Launching a Presentation from MCS

The web server in VBPresenter can be configured with either a domain name or an IP 
address. If configured with an IP address, you must launch the MCS client using the IP 
address in order to view presentations successfully; if configured with a domain name, you 
must launch the MCS client using the domain name. You cannot mix-and-match domain 
names and IP addresses or Session Expired and Maximum Viewers Exceeded errors may be 
displayed by the Portal Server.

Note that you must launch a VBPresentation from MCS. You can only view the video on the 
local machine where VBPresenter is running. The Portal Server uses the special icon shown 
here for VBPresentations. You can launch presentations from the Portal Server in two ways: 
live presentations (those currently in progress) are available on the Live Broadcasts page; 
stored presentations (those which have been "published" to the Portal Server) are available 
on the Video Library page.
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Figure 17.  Launching a Presentation from the MCS Portal Server

To launch a presentation from the Portal Server:

1. Launch the Portal Server and go to the Live Broadcasts or Video Library page 
depending on whether the presentation is live or stored.

2. Click on the icon for any available presentation. The presentation will run and the slides 
will be automatically synchronized with the video.

Publishing a Presentation from MCS

You can instantly publish your recorded presentation to your web server or a streaming 
server by selecting Publish Recorded Presentation from the VBpresenter toolbar. If MCS is 
configured as your web server, you can set Stored Presentation Values that describe the 
video and are searchable in MCS. You can also set an Expiration date in the format: 
yyymmdd-hhmm.

Note If you are just joining a live presentation, the first slide may not be displayed on your 
computer until the presenter clicks on a new slide or begins the presentation by going 
LIVE ONLINE (or until the duration in seconds exceeds the Auto Refresh value).
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Common Problems

Problem Solution

No slides get uploaded to 
my server.

Can you access your FTP account via the Manage button in the toolbar? 
If no, then you don't have the correct address / username / password 
entered for your server, or your server is not set up correctly. 

What is the viewing 
URL? Can I view it while 
I give a presentation?

• The presentation URL is automatically listed in e-mail generator. 
Click on the e-mail icon to view.

• The presentation URL is your server address + /optional folder + /
PowerPoint file name.

• You can open a browser to view your presentation the same way as 
your audience on the same computer, but you would not want to do 
this during a presentation because it may confuse you. 

Everything seems to 
happen correctly, but 
when I change slides they 
are not shown.

• Be sure you have selected LIVE ONLINE.
• There may be some delay due to the network, reflector server (if 

any), and the player. You may need to wait up to 15 seconds, 
depending on your configuration, to see the slides change. 

• Did you remember to enable Meta Data on your VBrick 
configuration.?

• Each time you change your slide, the Meta Data field in your VBrick 
should be populated with a new URL. Does this occur? Did you set 
your VBrick username and password correctly?

• Can you access your VBrick via the Manage button? If no, you do 
not have the correct address / username / password entered, or the 
VBrick is not on the same network.

• Did you set the Remote Directory setting correctly for the FTP 
server?

I can't figure out what to 
enter for the viewing 
URL.

Open a browser and enter http://ServerAddress/remote dir/

presentationname/s001.jpg. You should see the image of your first 
slide. If you do, your viewing URL is this without the /
presentationname/s001.jpg.  If this does not work, then the server 
address and remote dir is not correct or your web server is not set up 
correctly. Your remote directory must publish web pages (e.g. web 
sharing enabled on the server). 
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Some viewers report the 
slides are not showing 
up.

If at least one viewer can see your video and your slides, the problem 
cannot be at your end. It is possible they have popup blockers enabled 
or they may have a problem with their computer. 

Some viewers report that 
the slides are cut off the 
screen.

The viewer's screen resolution is set too low. The screen resolution 
should be at least 1024 x 768. When you upload your slides, select a 
smaller size (choice is large, medium, small). Normally, you should use 
"medium". 

Local viewers are not 
seeing the video via the 
multicast page.

• Do you have multicast enabled on the VBrick? 
• Does your local network support multicast? 

Cannot view a saved 
presentation.

• Are you certain you recorded your presentation? There should be a 
new folder with your presentation name, and the folder is located 
under the same folder as your original PowerPoint file. This folder 
should have your video file.

• You should be able to view your presentation by opening (double-
click) index.htm in Internet Explorer. 

• You can upload the entire folder to a web server "as is" if you are 
using WM and viewers can see your stored presentation via 
progressive download. 

No video. • You must use the VBrick "Slot 1" 
• Can you see the video via conventional means (e.g. via Media Player 

by entering the VBrick URL)? 
• Did you enter the correct video URL on the setup screen? Paste this 

entry into Media Player...does it play? If not, your VBrick is not 
streaming or the URL is incorrect. If yes, then perhaps the URL is 
not reachable by your intended viewers. 

What happens if I change 
slides very quickly?

Your viewers will likely skip any slide that is not displayed on your 
computer for at least two seconds. 

Can I get live audience 
feedback?

Yes. Your server must support ASP. You can use other methods to 
receive live audience questions (for example e-mail or IM) but using a 
telephone conference bridge and speakerphone is usually a bad idea. 

Can I do slides only (no 
video)?

No. But you can chose to send very low rate video (e.g. 1 fps at 20 
Kbps) and turn off your camera and microphone. 

Can I use the MCS Portal 
Server?

• Yes. The MCS Portal Server runs on a standard Windows Web 
Server. You can upload your entire saved presentation folder to the 
server if your video is WM format and view the saved presentation. 

Problem Solution
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Can I turn off the "click" 
sound each time a slide 
changes?

Yes. This is a Windows setting on your computer. Go to Start > Control 
Panel > Sounds and Audio Devices and set Complete Navigation to 
None.

How can I give a 
presentation to all my 
local employees and also 
to remote employees via 
the public Internet?

1. Configure your VBrick on your LAN.
2. Set your VBrick to multicast locally.
3. Set your VBrick to also stream to a reflector (for WM this is a WM 

server).
4. Send an e-mail to invite your participants using the built-in e-mail 

utility. This e-mail includes both viewing URLs. 

Can I edit the recorded 
video?

Yes. For WM you can use many third-party editors, or the free Movie 
Maker from Microsoft.

I recorded a presentation 
on my computer, then 
published it. By mistake, 
I deleted it. How can I 
restore it to the server?

Your recording still exists on your computer, so you simply need to 
upload it to your server. You might be able to do this via the Publish 
button if you have not created a more recent presentation. You can also 
open Setup and click on Manage for your web server. This will open a 
FTP window to your web server. Simply drag-and-drop your entire 
presentation folder to the server. The presentation folder is in the same 
directory as your original PowerPoint file and the folder has the same 
name as your original PowerPoint file. 

Can I use my corporate 
web server?

Usually. If your corporate web server is on a hosted (third party) 
Internet web server, you may or may not be able to add FTP accounts. 
If your FTP account puts you in to a top level directory (e.g. above 
"www" or above "htdocs"), then you must set the "Rmt Dir" field in 
setup to your target subdirectory. 

Multicast is enabled 
when I go online.

If you are not using multicast, set your VBrick multicast address to 
Loopback so that turning it on does not matter.

Problem Solution
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Frequently Asked Questions

Question Answer

What type of web server 
is required? 

VBPresenter uses ASP for certain functions, so your web server must be 
Microsoft (IIS). If you are using VBrick internal hard drive (WM models 
only), then VBPresenter formats the pages not to use certain functions 
and ASP is not used. Because the VBrick web server does not support 
ASP, Questions, Polling, and certain other features are not supported.

Do I need a streaming 
server? 

Maybe. For live video, see "When do I need a reflector service? "
For stored video, VBPresenter supports "progressive download" for 
WM video types and will publish your recording on your web server if 
you select Progressive Download. You should use a streaming server 
for larger video files and/or when you expect more than a few viewers.

Does VBPresenter work 
with VBrick's MCS / 
ETV system?

Yes. For WM video type, you must have a Windows Media server for 
stored video files.

What is the difference in 
operation using a 
conventional web server 
and VBrick MCS / ETV 
system?

When you use VBPresenter with a web server, the viewing URL of the 
live presentation is the PowerPoint file name. When you give a live 
presentation via MCS, you set up a special "channel" name that appears 
in the MCS live program guide. This allows a presenter to always have 
the same "channel" name (for example, "History 101" or "CEO 
Address") regardless of the PowerPoint name. For recorded 
presentations, MCS allows the presenter to enter a title, keywords (for 
searching), expiration date and publishing folder.
When used with a conventional web server, both the live and recorded 
presentation name is always the name of the original PowerPoint file.
VBrick MCS/ETV System provides granular permissions, allow you to 
limit the viewing to only authorized parties. When used with a 
conventional web server, the presenter may assign a password. When 
used with MCS / ETV System, no password is entered because the 
permission to view it is configured by the MCS (e.g. permissions are 
established by MCS at the folder level).

What happens when I 
publish a live 
presentation? 

VBPresenter creates special viewing pages based on the entries in the 
setup screen and uploads these to your web server (or MCS).

What happens when I 
publish a recorded 
presentation?

VBPresenter creates special viewing pages based on entries in the setup 
screen and uploads these to your web server (or MCS). VBPresenter 
uploads your recorded video file to your web server (if progressive 
download is selected) or your streaming server (if streaming server is 
selected). VBPresenter assumes you have first conducted a live 
presentation and subsequently modifies it by publishing the recording. 

Why don't the viewer's 
slides change? 

You have not published them. Are they present on your web server? 
You have not set the VBrick Metadata Enable You may need to set this 
in three places: under "video", under "server" and under "push". You 
have not correctly entered the VBrick IP address, username, and 
password.
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How do I install or 
remove VBPresenter?

To install, just run the setup program. To remove, run the setup 
program again and select "remove", or use the Windows control panel. 
With VBPresenter 2.1 and above, you do not use Tools > Addin. 
VBPresenter does not appear in the PowerPoint Add-In toolbar, but it 
does appear as a "customize" option. 

What is "PowerStream"? PowerStream is a company that provides WM reflecting service and 
VBPresenter web hosting. You may use other reflector services, such as 
Limelight, VitalStream, etc. but these services do not support the web 
server features and you will need to find a web server for the slides and 
html pages that VBPresenter uploads.

When do I need a 
reflector service? 

You need a reflector service if you wish to reach viewers on the public 
Internet, if you don't have an outside IP address, and/or if you do not 
have sufficient bandwidth to reach the number of viewers you wish. 
Most small companies will need a reflector service if they wish to reach 
viewing on the public Internet. Many larger companies have sufficient 
bandwidth or they have their own reflector.

Are Apple and Linux 
computers supported? 

Yes.

What is the difference 
between the "Video 
Viewing URL" and the 
"Video Recording URL"?

 The Video Viewing URL is the URL that is used by your audience for 
viewing the video (within the web page). The Video Recording URL is 
the URL that VBPresenter uses to (optionally) record the video. Because 
your VBrick is physically close to you and is a streaming server, you can 
have a better recording if you elect to record directly from it rather than 
from the Video Viewing URL which might be the URL of a reflecting 
server. 

How many local viewers 
can I have?

Unlimited. Both the VBrick WM appliance provides direct IP Multicast, 
enabling a virtually unlimited number of local viewers. Of course, your 
web server will need to support an equal number of sessions.

Can I show my live 
computer screen?

Yes. VBrick supports two video inputs and VBPresenter give you a 
built-in video switch. Connect the video output of your computer (if 
available) to one input and your camera to the other input. Show your 
live desktop by selecting the alternate video input.
Depending your preference, you might use 640 x 480 resolution for your 
VBrick WM appliance and remind your viewers that they may use the 
external video viewer if they would like a larger viewer. You can use the 
optional "VBPresenter Screen Capture" tool found on 
www.videoalive.com. This allows you simply press one button to capture 
your desktop and share it with your audience.

Why is a live presentation 
listed on the VBrick MCS 
even after I have closed 
PowerPoint? 

You must select OFFLINE before exiting PowerPoint. You can restart 
PowerPoint using the same presentation and select OFFLINE to remove 
the listing.

Question Answer

http://www.videoalive.com


52 © 2008 VBrick Systems, Inc.

Can I make a 
presentation that I can 
put on CD as a hand out?

Yes, for WM video type. When you create and record a presentation, it is 
located on your computer in a folder with the same name as the 
PowerPoint file. When you publish a presentation, you may also select 
Make Local File. Simply open the file called play.htm to view the 
presentation locally. Copy the folder to a CD and when you double-click 
on play.htm or drag it to Internet Explorer, your presentation will play 
(WM only).

Can I save the audience 
questions?

Yes. Press the Save History button on the audience questions viewer. 
You can also save just the "attendance" list.

Can I have multiple 
configurations?

Yes, as many as you like. VBPresenter Administration Utility allows you 
to create configuration files and they may be selected in the 
VBPresenter setup screen. You may elect to Hide Setup Button in 
VBPresenter when you create a configuration file. If you do this, then 
the VBPresenter user cannot access the setup, thus preventing the 
exposure of your server parameters.

Can I control or limit the 
number of live viewers?

Yes. Simply set the Max. Viewers. You can also set the maximum 
number of sessions that your VBrick will support. This is a good way to 
ensure your live video only reaches your intended audience: if you know 
you have invited only 20 people, then set you limit to 20. 

Can I integrate 
spreadsheets, word 
documents, and other 
material in my 
presentation? 

Yes, in multiple ways. You can copy the material into a PowerPoint slide 
and proceed normally. You can upload the material as "Reference", 
allowing your audience to obtain copies of virtually anything you post. 
You can use "Guided Web Browsing" to show any reference material to 
your audience (if it can be displayed in a browser).
You can use "VBPresenter Screen Capture" tool. This tool uses your 
current VBPresenter settings, captures your desktop image, and sends it 
to your audience in real time. For example, you would minimize 
PowerPoint, open up some other application, and press "Alt" to send an 
image of your desktop to your audience.

Can I integrate additional 
video into my 
presentation?

Yes. Simply type in the URL of the target video (.wmv, .mov, .sfw, etc.) 
using the Guided Web Browsing feature. You can also use the Guided 
Web Browsing feature to navigate to a web page that has video, 
animations, or other graphical elements embedded in it.

Can I customize the 
viewer interface?

Yes. You can insert you own logo in place of the VBrick logo.

Do viewers have to "log 
off"? What happens if 
they do not?

Viewers should log out when they leave. But if they just close their 
browser, the system logs them off automatically. If they just shut off 
their computer, then the log out will not occur. In this case, the system 
is configured with a timeout that you set in VBPresenter. The timeout 
should be set to at least the expected duration of your live presentation. 
If it is too short, then viewers will be unable to ask questions without 
logging out and then logging back in.

Question Answer
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Some links in web pages 
don't navigate viewers 
when using Guided Web 
Browsing. Why?

Guided Web Browsing only supports conventional web links. Some web 
sites use Javascript, Flash, or similar techniques that are not supported 
by VBPresenter. Prior to your presentation, you should verify the links 
you plan to use.

Why doesn't my first 
slide show up? 

Your first slide will be displayed under the following conditions: You 
select ONLINE. If you are already ONLINE, then the slides change only 
when you select (change) them in PowerPoint. If you set the Auto 
Refresh to 60 seconds, then the current slide will be refreshed every 60 
seconds. This is very useful to accommodate viewers that tune-in late 
and where the presenter lingers on one slide for long periods. You can 
elect to have an additional copy of your first slide so that when you 
advance to it the viewers see it in real time.

Do viewers require any 
downloads or plugins?

No. Most viewers already have the necessary player components 
installed on their computers.

Can I move my 
presentation from one 
server to another? 

Yes, but currently this will require some hand-crafting of the code. A 
utility will soon be available to make moving presentations between 
servers simple.

Can I use dual monitors? Yes. Simply select Resizable Video and move it to one monitor. Select 
Resizable Slides and move it to the other monitor.

Simple troubleshooting 
tips 

When you press the server Manage button, it should open Internet 
Explorer and you should see any uploaded folders. If this does not 
happen, then your web server address, username, password, and/or 
remote directory are not set correctly OR your web server is not set up 
correctly.
When you press the VBrick Manage button, it should open Internet 
Explorer and you should see the VBrick management interface. If this 
does not happen, then your target VBrick is not on, you have not 
entered the correct IP address, or there is a network issue reaching the 
VBrick.
If using Streaming Server, when you press the Streaming Server 
Manage button, it should open Internet Explorer and you should see 
the contents of your streaming server. If this does not happen, then 
your streaming server address, username, password, and/or remote 
directory are not set correctly or your streaming server is not set up 
correctly.
When you are online and changing slides, the Metadata field of your 
VBrick should become populated (Configure: Encoder > Video). If this 
does not happen then you have not correctly set the VBrick IP address, 
username, password and/or, port or your VBrick is not set up correctly.

Question Answer
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Server Setup You know your web server is set up correctly when:
• You can open a FTP session to it using the server address, 

username/password.
• You can upload a html page to it.
• You can view the uploaded html page by opening Internet Explorer 

and entering http://ServerAddress/RemoteDirectory/
uploadedPage.html

• The server is Microsoft IIS and ASP is enabled.
• The server has write privilege both the FTP user and for the web 

user.
For VBrick MCS/ETV System, you should create a new virtual FTP site 
on the server and follow the instructions in the MCS setup instructions. 
It is important that each user has their own virtual site on the web 
server. If multiple users use the same account, then they share the live 
audience questions too (which can be very confusing). Technical: Each 
account will have its own global.asa. 

VBrick Setup You must setup your VBrick. Generally, you will set the streaming bit 
rate(s), the http push(es), the multicast address, and the server(s). If 
using a reflector service (e.g. PowerStream), set the HTTP Push as 
instructed by the service provider.
For general purpose streaming via the public Internet, you will want to 
ensure your streaming bit rate is one your viewers can support. Most 
DSL/Cable modem "broadband" users can receive at least 300 Kbps. To 
ensure the widest support, you might set your VBrick WM appliance for 
multiple bit rates (e.g. 200 Kbps, 500 Kbps, 1 Mbps). Configure your 
VBrick streaming server and/or HTTP push for 200 and 500 Kbps (if 
you have adequate outbound bandwidth) and configure your multicast 
to use the 1 Mbps rate. 

Question Answer
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